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Molecule Maps
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Clone Manager draws molecule maps on screen (working maps) that you can use to locate molecule
features and enzyme sites or initiate actions. Clone Manager also sends high-resolution maps (graphic
maps) to your printer, to a disk file, or the Windows clipboard for use in other applications.

Working Maps
To view a molecule working map:
•
•

Open a molecule file or select a molecule from the Molecule List to open the molecule viewer
window.
If the map is not displayed, click the Map tab at the bottom of the window.

The basic working map will be either circular or linear, depending on the molecule. The map will show
features (genes, regions, markers) and enzyme sites, primer sites or label sites, as selected.
Genes -- appear on the map inside (below) the map line. The default style is solid arrow.
Regions (user-defined sections) -- appear on the map line. The default style is shaded box.
Markers -- appear as short, solid lines, crossing the map line. (not shown on sample above)
Enzyme sites (or primer or label sites) -- appear outside (above) the map line.
Click the Find toolbar button in the map window to find more information that can be added to
this molecule file. You can find enzyme sites (autoscan), find open reading frames (ORFs), find
primers that bind to this molecule or find sequence phrases present here.

To set the working map display options:
•
•
•

Click the Settings toolbar button.
Click the Screen Basics tab to set the working map display options (mark feature segment with
color, distinguish primers on complement strand, enable mouse hover, enable line smoothing)
Click the Features tab to set default map styles and colors for each feature type.

These settings will be remembered and used for all working map displays until you change the settings.

Mouse Actions
•
•
•

Point to a feature or enzyme name to see basepair position information.
Left-click on a site on map to select an enzyme or primer site (turns red when selected) or a
feature (segment shown) and then use toolbar buttons to initiate action or get information.
Right-click on a site to see a menu of common options, including GoTo Sequence that will jump
you to the formatted sequence at the position of this site.

Working with the Map Sites List
The Map Sites list is found on the right side of the molecule map display. This scrolling list shows enzyme
sites, primer sites, label sites, or features entered for this molecule. Click on a column header to sort the
display. Drag the join between column headings to resize column width.
Click the Change Sites button in the window toolbar to select to view enzyme sites, features,
label sites, or primer sites in the map sites list box. Features will always be displayed on the
working map, but they can also be listed in the map sites list. Enzyme sites are replaced with label sites
or primer sites both on the map and in the list, when selected.
Enzyme sites – the map sites list shows enzyme name, site position (marked at left end of recognition
sequence), type of ends produced (5’ sticky, 3’ sticky, or blunt) and an indication if this enzyme is a
single cutter (sc), cutting this molecule only once.
Features – list shows the feature name, start and end basepair positions, and an indication if this feature
is on the complement strand. A color segment can be shown on the map when a feature is selected (use
Settings to enable or disable color).
Label sites – list shows name, start and end positions and an indication is this on the complement
strand.
Primer sites – list shows primer name, site position (marked at 5’end of binding site), and an indication if
this primer binds to the complement strand.
Click on a site or feature in the map sites list to select an item, or click on the item on the map. A
selected feature will show a color segment on the map, an enzyme name will turn red.
When you use the Tools button in the map window toolbar, you have access to functions that
are specific for the selected item. If a feature is selected, tools include create protein, create
fragment or customize feature style. If an enzyme site is selected, tools include suppliers, isoschizomers
or compatible ends for the enzyme.

Use the GoTo Sequence button to move to the sequence view, formatted to show the selected
item. Click the Map tab to return to the map view.
Use the Properties button to view information about the selected item. For a feature, the
properties information includes feature details, translation, composition and codon usage.
For an enzyme site, the properties display shows the enzyme recognition sequence (in color) displayed
in the context of the flanking sequence. The cut position is marked by a staggered vertical line. Genes in
this area are shown as a line below the sequence.

Graphic Maps
The graphic map is a high-resolution map that can be sent to your printer, copied to the clipboard, or
exported to a disk file for use in other programs. You can use the Settings button to change the
appearance or content of the high-resolution graphic map before printing.
You can turn on or off the printing of types of basic text information, select styles and colors for each
feature type, select enzyme site styles, or change the size or position of the graphic map or add
descriptive text to the map page. Changing most map print options will not affect the appearance of the
working map in the molecule viewer window (with the exception of feature styles and colors), but will
affect printed, copied or exported maps.
To set map print options:
•
•
•
•
•
•

Open a molecule file and click the Map tab to view working map
Click the Settings toolbar button to set map default styles for printing.
Click the Print Basics tab to set font face, indicate which items to print,
and assign text colors.
Click the Features tab to set default map styles and colors for each feature type.
Click the Sites tab to set font size, color for site names and ticklines and indicate if you want to
use basepair numbers or italics for enzyme sites.
Click the Content tab to add molecule description and notes and/or a list of features and map
sites to the printed map page or to change the molecule map size.

When you select a graphic map style for printing that adds additional text to the map page, the map will
automatically be reduced to 90% of full size and it will be moved upward from the center to make room
for the extra text.
To change the style or color of an individual feature:
•
•

Click on the feature to select.
Click the Tools toolbar button and select Customize Feature Style.

•
•

Or right-click on the feature and select Customize
Set the style and color for this one feature or reset to a default style.

Print, Copy, Export Graphic Map
Graphic maps can be sent to your printer, copied to the clipboard or exported to a disk file for use in
other programs. To get started open a molecule file and click the Map tab to view the working map on
the screen.
Click the Print button on the main toolbar to send the map to your printer. Click File, Other
Tools > Print Preview if you want to check the appearance of your map before printing.
Click the Send View to Clipboard button on the main toolbar to send the map to the Windows
clipboard for use in other programs.
Click the Send View to File button on the main toolbar to create a disk file in Enhanced Windows
Metafile (*.emf) or Windows Metafile (*.wmf) format.
For web page use, click the Save for Web toolbar button in the map window to prepare a special
raster graphic map in a web-friendly (*.png) format.

Enhanced Views of the Graphic Map
You can use an Enhanced View to create a special graphic map, perhaps for a presentation or
publication. When you start a new enhanced view, you begin with the standard molecule map,
formatted for printing. You can then adjust each individual feature’s style, color, pattern, or position.
You can drag feature names with the mouse, to position them just where you want them. You can
directly control the font face, font style, point size and color for enzyme, primer, or feature names, or
the molecule name or size text. You can control the thickness and color of lines and even switch
between circular or linear map formats.
To start an enhanced view map of the active molecule:
•
•

Open the molecule viewer window and click the Map tab.
Click the Enhanced View button in the window toolbar and select New View.

When complete, you can save the Enhanced View to the molecule file for later use. As many as 6
enhanced views can be saved with any molecule file. You can print the enhanced map, copy it to the
clipboard, or export it to a disk file for use in other programs. Please refer to the on-line help or the user
manual for more detailed information about using this function.

Sequence Display

2

Clone Manager has a wide variety of formatting options for sequence and associated data elements. You
can set the display style for the sequence and you can select the additional information that will appear
along with the sequence – display any combination of sequence, enzyme sites, sequence labels, primer
sites, translation, annotation. Once the sequence display is just the way you want it, you can remember
the style for later use. You can copy the formatted sequence to the Windows clipboard or send it to your
printer or to a disk file for use in another application.

Sequence Style
To view sequence data:
•
•

Open a molecule file or select a molecule from the Molecule List to open the molecule viewer
window.
Click the Sequence tab at the bottom of the window.

If you want to view only part of a sequence, click the Zoom button (left end of tab bar at bottom of
window). Select the option Zoom to Show Region Specified and enter the start and end basepair
positions for the region to display.
To set the sequence format options:
•
•
•
•

Click the Settings toolbar button
Click the Style tab if not already selected
In the Sequence options area (center), select single- or double-stranded
Select block size (10 or 3) and choose upper- or lower-case letters

Show Additional Information
You can use the Settings dialog box to select the additional information that will appear along with the
sequence and you can set the default colors for sequence text items.
Use the check boxes to indicate which items should be displayed with the sequence data and set related
options (see below).
Enzyme Sites – shown above the sequence line. Select the source of the enzyme data: you can use
enzymes sites that appear on the working map, enzyme sites that the program will find using the
AutoScan enzyme list, or enzyme sites that are currently shown on the RMap tab.
Marking the enzyme recognition position above the line of sequence shows the precise location of
important enzyme cuts. When combined with other annotation information, enzymes can be quickly
selected based on the cloning or analysis task needed.
Primer Sites – shown above the sequence line. You can select to show primers with colored bases and
an arrow indicating direction or you can use two colors, using colored bases in a rectangle of color.
(Primer sites display requires Clone Manager Professional.)
Sequence Labels – shown on the sequence line itself. You can display sequence labels by coloring the
bases in the sequence and/or applying color to the background behind the sequence bases, or you can
invert the case of the sequence characters.
Labels are most useful for short sequences that have special significance, like a binding site for a
regulatory cofactor or a processing site.

Translation – shown below the sequence line. Show 3 frames, single frame 1, 2 or 3 (as selected), or all 6
frames of translation. Show amino acid codes in 1-letter, 1-letter with amino acid numbers, or 3-letter
styles.
Annotations – shown below the sequence line. Show genes, all map features (genes, regions, markers),
or translated genes. For translated genes, you can select 1-letter, 1-letter with amino acid numbers, or
3-letter amino acid codes.

Set Default Colors
You can select the default color to be used for each type of sequence text that can be displayed. Colors
can help to distinguish one type of text from another. Colors selected for feature annotations will apply
to all features of that type, but you can use a custom feature setting to distinguish a special feature (see
below).
To set default sequence text colors:
•
•
•
•

Click the Settings toolbar button
Click the Colors tab
Select the preferred text color for each item type. Different sequence annotation
colors can be set for genes, regions, and markers.
Select the preferred background color (second option box) for primer sites or sequence labels.
This background color will be used if two color style selected.

To remember your settings:
•
•

Click the Style tab
Click the Memorize button
When you start a new work session and want your sequence display to use your remembered
settings, click the My Style toolbar button in the sequence display window.

Customize Sequence Annotations Colors for Features
You can set a different color for one individual feature, to make this feature stand out in the sequence
display. This may be especially useful for sequence labels, where you want to distinguish one special
part of the sequence from the rest of the sequence. Or you may want to color the sequence annotation
for individual genes in a distinctive color, perhaps the color used for this feature on the graphic map.
To set custom feature colors:
•
•
•
•

Click the Features tab to move to the features table.
Select (highlight) the feature you want to change.
Click the Customize Feature button on the window toolbar.
Select the color for the sequence annotations text in the lower area.

In the features table view, a boxed area below the list is used to show the styles set for the selected
feature. If this box is not visible, click the Settings toolbar button and select Show selected feature styles
in lower area.
Click the Sequence tab to return to the sequence view.

Sequence Data Tools
While viewing sequence data, you can find places in the sequence that match or nearly match a specific
pattern of bases. You can jump to each occurrence found in the sequence display or you can view a
report listing all of the sites found on both strands of the entire molecule. When sequence is highlighted,
either with a found match or because you selected it with your mouse, you can use options on the Tools
menu to enter this highlighted sequence as a feature or create a primer.
To find a sequence match:
•
•
•
•
•
•

With the sequence visible on the screen, click the Tools button
Select Find and enter the sequence of bases to search for
Use the checkboxes to configure the search to permit limited mismatches or mismatches and
gaps or insertions.
Select Go To to jump to and highlight the sequence match found
Use checkboxes to search only the upper strand and to start at the beginning of the sequence
Click Tools again and then Find Next or use Ctrl + I to locate additional matches

To enter selected sequence as a feature:
•
•
•
•

Select (highlight) sequence bases with the mouse (hold down left mouse button and drag).
Sequence basepair numbers for the start and end of the selected region are shown in the
window toolbar at the right, along with the length (number of bases)
Click the Tools button and select Enter as Feature
Give the feature a name and description and select the Draw as Type (gene, region, marker,
label) and set the default style.

Edit Sequence
You can edit the sequence of a molecule by adding or removing bases. You can be in single-stranded,
double-stranded, or translated mode, but you can only edit the upper strand of the molecule.
Click the Edit toolbar button and make changes as needed and then click the Accept Changes (Update)
button to complete the changes you made and modify the sequence of the molecule. Or click the
Discard Changes (Cancel) button to abandon your changes and leave the sequence unmodified.
Clicking either button will leave the edit mode and allow you to move to another task.

Molecule Features
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Clone Manager has a features table display in the molecule viewer window. Molecule features appear in
the listing with a symbol for the feature type, the feature name, basepair positions, description, and the
feature key, if assigned. You can show a simple features map above the list and/or a box showing the
feature styles for the selected feature below the list. Click toolbar buttons in this window to add, edit, or
delete features, view feature properties, create a protein or fragment, export the feature sequence, set
custom print styles or filter the data displayed.

Features Table Display
To view the features table:
•
•

Open a molecule file or select a molecule from the Molecule List to open the molecule viewer
window.
Click the Features tab at the bottom of the window.

Feature Types
Feature Draw as Types are used to tell the program how to draw the feature on the molecule map or
show the feature on the annotated sequence. Molecule feature types include Genes, Regions, Markers,
Labels and Information-only features. You can set the style and color to be used for each feature type
for molecule maps or annotated sequence.
Genes – usually represent translated sequences, have start and end basepair positions, can be
on the complementary or normal strand. Shown on the molecule map and annotated sequence.

Regions – zones of special significance for the user, have start and end basepair positions, can be
on the complementary or normal strand. Shown on the molecule map and annotated sequence.
Markers – markers have a direction, occupy one base position, can be on the complementary or
normal strand. Markers can appear on the molecule map and annotated sequence.
Labels – sequence areas of special interest to the user, have start and end basepair positions.
Labels can be shown on the annotated sequence and appear on the molecule map as label sites.
Info-only – not shown on the molecule map or on the annotated sequence. Use for features
where you want to preserve the information but do not want it to clutter your map.
To set the features table display options:
•
•
•
•

Click the Settings toolbar button
Select to show feature bp numbers start-to-end (standard) or left-to-right
Use checkboxes to select to show information-only features, the simple features map above the
list and the selected feature styles in a boxed-area below the list.
Click the Memorize button to remember these settings

Use the Features Table Filter
If your molecule has a very large number of features, you can click the Filter button to set filter
options to transiently limit the data displayed by location or feature type. Click the depressed
Filter button to remove the filter.
Filter by Feature Type – Use the check boxes to indicate the feature types you want to display. You can
select more than one option. Leave all of the checkboxes blank to display all feature types.
Filter by Location – Check the box for this option and then enter the two basepair position numbers that
define the region where you want the features listed. All features that are found within this region will
be shown, even if the feature is not fully contained within the region.

View Features Information
To get more information or use feature tools, open a molecule file and click the Features tab and then
select (highlight) a feature.
Click the Feature Properties toolbar button to get more information about the selected feature.
For Genes, properties include basic information about this gene, its translation, and the amino
acid composition, codon usage, molecular weight and pI for the translation product.
Click the GB Location/Qualifiers button to view GenBank location or qualifiers. The information
displayed includes feature location data (basepair positions) and qualifiers available for this
feature. GenBank format files imported into Clone Manager will read in all feature qualifiers and retain
this information when saved as a Clone Manager file. Click outside the pop-up box to dismiss.

Use Feature Tools
Click the GoTo Sequence button and select Go To Sequence Start or Go To Sequence End to
move to the sequence view, formatted to show the selected feature. Click the Features tab to
return to the features table display.
Click the Tools button and select options to Make Protein, Make Fragment, or Export Feature
Sequence for the selected feature.
When you select to make a fragment from a feature, you create a new molecule containing the feature
sequence, with the option of including extra bases at each end and you can set the fragment orientation
for the new molecule. When you select to export the feature sequence, you can select to export to a
disk file or to copy to the Windows clipboard for use in another application.
Click the Customize Feature button to set a custom style and color to be used for this feature for
the graphic map or set a custom text color to be used in the annotated sequence display.

Add or Edit a Feature
Click the Add Feature toolbar button to add a new feature or the Edit Feature button to make changes
to the information for an existing feature. Then enter or modify the feature information.

For a standard feature, enter the feature name, feature key, and feature description in the upper area of
the dialog box. Select the Draw as Type (gene, region, marker, label or info-only) and assign a default
Style. (Default styles are set using Settings, Style on the Map tab.) You may choose to Edit a feature to
change the Draw as Type for some Info-only features so that they appear on the map or annotated

sequence, or you may want to change a region to a gene if you want to translate this feature and create
a protein.
When entering new features, you can select the appropriate feature key from the drop-down list of keys
supported. Your designated feature keys appear first, but you can click More… to see all of the possible
feature keys. (You can tell Clone Manager which features should be imported, based on feature key,
when you open a file in standard GenBank or EMBL format. These are your designated feature keys –
click File, Preferences, then click the Import Features tab to set this.)

Using GenBank Feature Qualifiers
For more complex features with joins or qualifiers, you can enter or edit this information in the lower
areas of the Add or Edit Feature dialog box. Clone Manager supports all of the GenBank/EMBL feature
keys and has support for mandatory qualifiers.

When you entered a new feature, you selected the appropriate feature key from the drop-down list of
keys supported. Standard qualifiers will be generated based on the Feature Key you selected and
mandatory qualifiers will be identified (if any) and shown at the top of the list.
Click the Add button to enter a new qualifier. Select the qualifier name from the list provided and enter
the qualifier value. When you select a mandatory qualifier and then click Edit you will see the list of
possible qualifier values or you can type in text, if appropriate. Do not enter quotation marks.
Click the Edit or Del button to modify or remove the selected qualifier. Right-click to move a qualifier up
or down in the qualifier list.

New Sequence
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Clone Manager can read molecule files in standard GenBank, EMBL, or FASTA formats. It can also import
plain sequence data, perhaps from a sequencer-generated data file or sequence data sent in an email
from a colleague. Sequence can be in upper- or lower-case letters and the program knows how to
handle basepair numbers and spaces between blocks of bases. Non-sequence lines (comments), if
present, should start with a semi-colon.
On occasion, you may have to get a sequence for a vector you plan to use. The manufacturer’s website
usually has vector sequence data for your use and you may be able to download a file prepared in
GenBank format. If a prepared file is not available, you can copy and paste the sequence data to use in
Clone Manager.
Once you have imported your new sequence data, you can explore the sequence and add additional
information to complete a more complex molecule file. You can add features (like genes), enzyme
recognition sites, a molecule name and description, and notes or comments about the sequence.
To read in sequence data from the clipboard:
•
•
•

In your e-mail document or other Windows workspace, select (highlight) the sequence data.
Click Edit, Copy (or Ctrl + C) to place the sequence data on the Windows clipboard
In Clone Manager, click File, Other Tools, Import from Clipboard

If the sequence data can be read, Clone Manager will automatically get ready to do an AutoScan
operation to find enzyme sites.

Problems with Reading Sequence Data
If the program cannot automatically load the sequence, it will identify the closest of the recognized
formats and try to provide you with information about the problem encountered and provide help with
file loading. In the File Help module, you will find the error described in the top right. The scrolling data
window shows the contents of the file. Usually, you will have one of the common file loading errors (like
an unrecognized character in file). You can click the Go To Error button to move to the problem point
and correct it. Then click Retry Load. (Please refer to the Help Topic “Problems with File Loading” in
Clone Manager for more detailed information.)

Find Enzyme Sites
Once your sequence data has been read into Clone Manager, a new molecule file is in the process of
being created. The AutoScan operation is the next step. This operation will look for single cutters and
automatically enter the enzyme sites to the molecule map in one easy operation. The enzymes used for
the default AutoScan operation are major, commercially-available enzymes with recognition sequences
of 6 or more bases.
In the AutoScan dialog box, you can check that the number of bases imported is correct, you can set the
molecule style to be circular or linear and you can initiate the AutoScan operation. The molecule does

not yet have a name, but you can add one, as well as descriptive information or comments (see later
section). Click OK to move on and perform the autoscan.

Alternatively, you might want to add all of the enzyme sites for just the enzymes you have in your
freezer. This is where user enzyme lists come in handy. To add these additional enzyme sites to your
molecule:
•
•
•
•

Click Clone, Find Enzyme Sites
Set the Enzyme List to your user list (on right)
Set the option for List of Enzymes (on left)
Select find All Sites User List

Enter Features Information
If your vector data from the manufacturer’s website had information about genes, regions of interest, or
special parts of the sequence (like promoters), you will want to add this information to the Features
Table in Clone Manager. (If you were able to download a file in GenBank format, this information was
automatically entered for you, based on your GenBank import filter settings.)
•
•
•
•

Click the Features tab and then click the Add Feature toolbar button
Enter the Feature Name (a short name looks good on the map) and
select a Feature Key (optional)
Enter the Feature Description and select the Draw as Type and Style
Enter the start and end basepair positions and indicate if on the complement strand

You may also want to do a search for open read frames to see if there are other features you might want
to add to your new molecule file or to verify the positions of the features you may have entered from
published data.

Find Open Reading Frames
When you do an ORF search, you can identify the start and stop codons you require and set the
minimum acceptable ORF size. When the search is completed, you can select ORFs to add to your
molecule as possible genes.
To start an ORF search:
•
•
•

Select Find Open Reading frames on the Discover menu
Identify the Start codon and the Stop codons you require
Set the minimum size (in amino acids)

•
•

When the results appear, click on a column header to sort by position, frame or size
Select (highlight) an ORF (shown on map in lower area as red arrow)

•
•

Click Enter Gene to add this ORF as a gene in the features table
Add the feature name, description, draw as style in the Add Feature dialog box.

If your molecule already has genes in the features table, they will be shown in the molecule map display
in the lower area.
To see all of the listed open reading frames positioned in their approximate locations in the six
translation frames, click on the Show Overview option. The overview display will replace the iconic map
display. The highlighted ORF in the scrolling list is shown in red.

Enter Molecule Information
To begin with, your molecule has a place holder name. You can enter or change the molecule name, and
add a description and notes for the new molecule file.
•
•
•
•

Click the Info tab and then click the Edit toolbar button
Enter the Molecule Name and Description
Enter Notes information. (The first line of Notes text can be seen in the
Molecule List window, so put what’s most important at the top.)
If you got vector sequence data from the manufacturer’s website, you can add
this information in the notes field.

Once you have saved this file to disk (see below), Clone Manager will add the file name and file location
to the molecule information display.

Save Molecule File
Remember to save your file to disk when you’ve finished adding all your
new information. Just click the Save button on the main toolbar.

Simulate Cloning

5

Clone Manager 10 has an updated Ligate module to help you simulate cloning. You can use the Ligate
option to join together two or more pieces of DNA or to join the two ends of the same molecule (selfligate). The ligate display window lets you see the molecules as they are being prepared for ligation.

Use the Ligate Function
To get started:
•
•
•

Open a molecule file or select a molecule from the Molecule List to open
the molecule viewer window.
Click Clone, Ligate to open the Ligate window.
Click the Add Molecule toolbar button to add the other molecules or
fragments needed for the cloning simulation.

In the upper half of the Ligate window, an icon map of the active molecule is shown, with features (if
any). If enzymes were used to create the molecule’s ends, these enzyme names appear above the
respective end. The actual sequence of each end is shown below the map. The molecule in this upper
window can be modified (see below).
In the lower half of the window, all of the molecules or fragments are shown in boxes. Click the Add
Molecule button to select additional molecules to add to this window, if needed. You should arrange
these molecules or fragments in the order in which they should be joined. Click on a molecule and drag
to move to the right or left, as needed, or use the Move or Select Fragment toolbar button.

Small icons appear between each fragment box to indicate if ligation is possible. If changes are needed
to a fragment to enable ligation, click to select the fragment, causing it to appear in the upper box,
where modifications can be made.
Use the Fragment Information button to view the features table for the active molecule or to
find enzymes that could prepare ends that would be compatible to the fragment to the left or
right of this fragment in the lower window.
Compatible Ends information is available for the fragment ends at the far right and far left of the
fragment display so that you can check for compatibility, assuming you will want the ligation procedure
to circularize the end molecule.

Preparing Molecules/Fragments for Ligation
You can use the Cut operation to prepare DNA for ligation. You can cut a circular molecule to make it
linear, cut out a region to be cloned, or cut with an enzyme to make a compatible end. Clone Manager
can cut DNA at enzyme cut sites or at user-specified basepair positions. You can use enzyme sites
already entered for this molecule, or Clone Manager can find sites for 1, 2, or 3 enzymes you select and
then cut with these enzymes at all sites found.
To use the cut operation:
•
•

Select (click on) the molecule to cut.
Click the Cut toolbar button.

•
•

In the Cut Molecule dialog box, click Enzymes to cut with an enzyme
Type in the enzyme name or select it from the list at right.

If the cut operation results in multiple molecule fragments, you can select one fragment for use in the
current operation or identify one or more fragment to create for later use. Each fragment is listed with

the start and end basepair position and the length of the fragment. The highlighted fragment is
displayed on the iconic map below the list.

Select (highlight) the fragment you want and click the Use Now button. This fragment will replace the
original molecule in the ligation window.

Modify Molecule Ends
You can use the Modify Ends operation to change the ends of a linear molecule to prepare it for ligation.
You can use Klenow Fill-In, 5’ -> 3’ exonuclease, 3’ -> 5’ exonuclease, or Partial Fill-In modifications to
change the molecule ends.
To modify the fragment ends:
•
•
•

Select (click on) the molecule to modify.
Click the Modify Ends toolbar button.
Select the end modification you want to use.

Klenow Fill-In – treatment with DNA polymerase I Klenow fragment will fill in 5-prime overhang
extensions of the molecule to create a blunt end.

5’ -> 3’ Exonuclease – treatment with 5’ -> 3’ exonuclease will remove bases from the 5-prime singlestrand ends of the molecule.
3’ -> 5’ Exonuclease – treatment with 3’ -> 5’ exonuclease will remove bases from the 3-prime singlestrand ends of the molecule.
Partial Fill-In – select this option and then use the check boxes to select the bases A, C, G or T to partly
fill in 5-prime overhang extensions.
The proposed end modification is shown on the display in red base letters, where bases are added, or
green crossed-out letters, where bases are removed.
Select Modify to change the molecule ends as shown and alter the sequence for this DNA.
Click the Invert Fragment button if you need to reverse (invert) the sequence of the
selected fragment.
If a change you made to a fragment is not what you expected, click the Undo Last Operation to
undo the last modification to the selected fragment.

Complete Ligation
When all of the fragments are ready, click the Ligate button to join all compatible ends of the
fragments in the order shown.
After ligation, a circular recombinant will be rotated to restore the original reference frame of the
vector. If you do not want the ligation operation to circularize the molecule, click on the drop-down
arrow to the right on the Ligate button and select Do Not Circularize.
Once ligation is complete, you can enter the molecule to the Molecule List for further use or save it to
disk.

Notes:
The newly-ligated product has been scanned using all enzymes present in all starting fragments and the
map sites list updated. If you would prefer to limit the enzyme sites for the new molecule to only single
cutters, you can click the Find button in the molecule map window toolbar and select Find Enzyme Sites
(Autoscan) and select to Replace Existing List with New Sites Found.
If you would prefer to have a different base position at the top (origin) of the map, you can click Tools
on the main menu and select Process Molecule, and then select Rotate Molecule.

Cloning Wizards
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Clone Manager 10 has a number of wizards that will help you to simulate cloning using a variety of
techniques. The wizards will help you select the appropriate components, show you the proposed result,
and create the resulting recombinant molecule. There are often a number of settings you can adjust, if
desired, but the default settings will usually be just what you need.
Gateway Cloning -- The Gateway cloning wizard will help you to simulate cloning using Gateway®
Recombination Cloning techniques (Invitrogen Corp). It will help you make an entry clone (BP reaction),
make an expression clone (LR reaction), prepare a PCR product with attB sites, or perform complex
MultiSite procedures. If you are using a Multisite Pro kit, the wizard will walk you through constructing
multiple fragments with the right attB sites and donor vectors.
Topoisomerase Cloning -- The Topoisomerase cloning wizard supports cloning using Topo® Cloning
techniques (Invitrogen Corp). You can do TOPO TA Cloning, Directional TOPO cloning, Blunt TOPO
cloning, or prepare PCR products with added terminal bases as needed. You can indicate your primer
design goal and your preferences for GC content adjustment or primer criteria stringency.
PCR Cloning -- The PCR Cloning wizard can help you to design PCR primers to amplify the region of a
molecule you want to clone, use enzymes to prepare the vector or the region for insertion, and then
generate recombinant molecules. It will help you with Topoisomerase cloning, Classic TA cloning,
restriction enzyme cloning and blunt end cloning, all using PCR amplification. You can view several
solutions and save selected primers, amplified products and recombinants for later use.
Assembly Cloning -- You can choose from several assembly cloning wizards to help you simulate cloning
using Gibson Assembly™ (Synthetic Genomics, Inc), In-Fusion® Cloning (Clontech Laboratories Inc),
Ligation-Independent Cloning, or related cloning techniques. Use the Ligation-Independent Cloning
wizard to join fragments previously prepared with correct overlaps. Use the Gibson cloning or In-fusion
cloning wizards to use PCR to create amplified fragments with overlaps, and then assemble the
fragments, using the assembly procedure selected.
After using one of the wizards, you can view the proposed result and create the recombinant molecule.
If you are using Clone Manager Professional and have designed primers to amplify the fragments and
create the overlaps, you can view more detailed information about the primers, save the primers to a
collection file, or export the primer sequences.

Example: Simulate Classic TA Cloning
To get started:
•
•
•
•

Click Clone, PCR Cloning Wizard. Click Next.
Select Classic TA Cloning and click Next.
Click the Change button to select or change the molecule that contains the
region you want to amplify for cloning
Enter the upper strand coordinates of the region you want to clone
(you can set the orientation of the insert later)

To set the primer design options (next screen):
•
•
•

Set the primer type to PCR Primer
Leave all of the options set to default, unless you specifically want to override
You can modify the primer type, optimal primer length, and search extent, if desired.

To specify preferences (next screens):
•
•
•

Leave all of the adjustment settings at default values, unless you need to override
You can adjust the GC content acceptable range, the criteria adjustments allowed, and search
region adjustments, if needed when a search for PCR primers is not successful.
On the next screen, for bases at the 5’ end of your PCR primers, leave the setting marked to
Avoid 5’T if possible.

To define the vector you want to use (next screens):
•
•
•

Click the Change button and select a vector molecule. The wizard uses circular molecules.
Identify the region you want to clone into and click Next.
Select the enzyme you want to use to cut the vector and set the orientation of the insert. The
enzymes shown cut only inside the region specified and do not cut the insert molecule.

•
•

Click Next and review the instructions, selecting the number of solutions to display.
Click Finish to view the cloning simulation results.

Classic TA Cloning Results
If possible solutions can be found for the cloning experiment you described, the selected number of best
solutions can be viewed sequentially. For each solution, an iconic map of the recombinant molecule is
shown, with the insert marked in a lighter color, inserted in the direction indicated by the arrow. If
features were present in the vector or insert molecules, these features will be shown above the map
line. The area below the map shows detailed information about the molecules, primers, enzymes used.

Use the Next Solution button to view the next solution in the set. Use the Previous Solution
button to return to a prior solution in the set.
The Solution Details button lets you view, print or copy a detailed summary of the cloning
experiment, including primer sequences, positions, lengths and Tm values.
Click the Create Molecule button to have the program automatically do the required steps to
simulate the cloning experiment, produce the recombinant molecule, and enter it to the
Molecule List. Enter a molecule name for your new recombinant and modify the description, if needed.
For Gateway cloning results, you can also click the Use Now button to take the molecule shown and use
it in the next logical step in Gateway cloning. If you have just done a BP reaction, for example, the Use
Now action will start an LR reaction using the entry clone you just created.
For Topoisomerase cloning results, if you have just prepared a PCR product, you can click the Use Now
button to take the amplified product shown and use it in a TA, directional, or blunt topoisomerase
cloning procedure.

After clicking the Create Molecule button, the new molecule will open in a new molecule viewer
window. You can examine your results and return to the PCR cloning results window to select another
recombinant or view primer information. Here’s our new recombinant molecule:

Viewing More Primer Information
If you are using Clone Manager Professional and have designed primers to amplify the fragments and
create the overlaps, you can return to the cloning solution results screen and view more information
about the primers. For some results displays, you can use the drop down list box to move from the
Summary view to the view of primer pairs for each fragment.
In our results view, you can view a primer report, enter the primers to the primer list, export the primer
sequences or create the amplified product.
Click the Primer Pair Report button to view the evaluation report and related primer analysis
screens for the primers associated with this solution.
Click the Enter to Primer List button to add these primers to the list of loaded/active primers
and also add these to a collection file.
Click the Export Primer Sequences button to export or copy the two primer sequences
sequentially to a disk file or to the Windows clipboard.
Click the Create Amplified Product button to use the two primers and source molecule shown
to prepare the PCR product. You can enter this to the molecule list and open for use now, save
to a disk file, or export the product sequence to an ASCII text file.

Search for Primer Pairs
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Clone Manager can search the molecule and region you specify, looking for primers that meet the
evaluation criteria you set. For PCR primer pairs, you can indicate if you want to amplify a complete
target region or just a fragment within a specified size range. Results are listed with basic information
about each primer pair. You can sort the list and analyze or use any of the primers found. An alternate
view lets you see which evaluation criteria eliminated possible primers during the search.
To get started:
•
•
•
•

Click Primer, Design.
Set the option Search for Primers and select the Primer Type.
In the lower area, set the option to Optimal Length or Required Length,
and enter the number of bases for Primers A and B.
If using Optimal Length, set the acceptable range of bases for each primer.

•

Click Next to identify the source molecule and target region.

•
•

Confirm that the source molecule shown is the one you want to use or
click Change to select a different molecule.
Next, enter a target region. You can use the Features button to access the Features Table for
this molecule and paste in the start and end basepair positions for a feature.

•

Indicate if you want to amplify the complete target region or just a fragment in this region and
enter the search extent or acceptable product length.

•

Click Finish to complete the instructions for the primer search.

Primer Search Results
When a search has been completed, the results will be displayed in the Search Results or Search
Statistics windows. If the search was successful, primers found will be listed in a table format showing
basic information about each primer or primer pair. You can use the combo box in the window toolbar
to sort the list by quality (rank sort), position, or product length.

If you want to adjust the search to find additional primers, you can try the Auto Adjust Length or Auto
Adjust Criteria buttons to make quick adjustments and repeat the search to try to find other primers
(particularly useful if your search yielded only a short list of primers or pairs).

Click the Enter to Primer List button to add the primer or pair to the Primer List, entering a
primer name and description. When entering to the Primer List, you can also add these primers
to one of your collection files.
Click the Enter Primer Site to Map button to add the primer binding site for the selected primer
or pair to your molecule file as primer map sites that can appear on your molecule map or
annotated sequence.
Click the Primer Report button to view a report for the selected primer or pair. The Primer
Viewer Window will open with primer report data visible and access to more detailed analyses.
With the Primer Viewer Window open, you can click the Info tab to view information about the primer
sequences and the amplified product.

Click the Create Product button in this window to create a new DNA molecule that is the PCRamplified product of the two primers and associated molecule shown.

Alternate Search Results View
The Primer Search Statistics Display is an alternate to the search results display and shows which criteria
eliminated primers or pairs during this search. The program initially identifies all possible primers in your
search region. It then begins to eliminate primers that fail to pass the tests shown. The test steps are
sequential, and only primers that pass a given test are considered in the following test(s). The number of
primers tested and eliminated in each step is reported numerically and displayed as a bar chart on the
right (eliminated primers are shown in red).
Click the Search Results/Search Stats toolbar button to see where criteria eliminated primers. (If
no primers were found initially, the Search Statistics display is the only display available.)

Finding more primers
When a search has been unable to find sufficient primers that meet all of the evaluation criteria, you can
modify the search conditions (vary primer length or relax evaluation criteria) or you can redefine the
search region to increase the size of the search range. (Use the Redefine button in the results window to
return to the search setup dialog box to change the search range.)
Changing the primer length by one or two bases may have an effect on the number of primers found
within the area specified and meeting the criteria selected. Or you may be willing to accept a slightly
longer run of bases or an increase in non-3’ dimers, without changing primer length.
Auto Adjust Primer Length – use this function to start an automated sequence that will repeat
the primer search, adjusting the primer length as specified, and then display the new results.
Auto Adjust Primer Criteria – use this function to start an automated sequence that will adjust
(relax) primer evaluation criteria, repeat the search, and then display the new results.
In the Auto Adjust Primer Criteria dialog box, select Conservative or More Aggressive to adjust (relax)
the settings marked at the right with gray checks. Or select Custom and then check the individual
criteria settings that you want to adjust (relax), using the Search Stats display to see which criteria
eliminated primers.

Finding More Primer Pairs
The Search Stats display for a primer pair search has three results. If pairs have been successfully found,
the display shows the pairs results. Buttons in the lower right can be used to access statistics for Primer
A or Primer B separately. When a search has found Primer A candidates and Primer B candidates, but is
unable to find A:B pairs meeting your criteria, you can modify the matching criteria to accept larger
differences between the two primers. On the Auto Adjust Primer Criteria dialog box, click Custom and
check the boxes for Pairs GC Match and/or Pairs Tm Match to relax these matching criteria.

Create Primer from Molecule
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Clone Manager can create a PCR primer, sequencing primer, or probe using the sequence of a source
molecule. The program will position a primer of the length you specify at the initial position you specify.
You can then move the primer along the sequence or adjust its length until the primer evaluation meets
the criteria set. This design option is especially useful if you must have a primer very close to a specific
location in your molecule.
To get started:
•
•
•

Click Primer, Design.
Set the option Create from Molecule and select the Primer Type.
Enter the primer length (required length) and the 5’ extension (if any).

•

Click Next to identify the source molecule and target position.

•

Confirm that the source molecule shown is the one you want to use or
click Change to select a different molecule.

•

Enter a target position for initial placement of the primer and use the checkbox if you want to
design a primer using the complement strand.

•

Click Finish to create the primer and enter a primer name and description when prompted.

The Primer Viewer Window will open, displaying your new primer and its evaluation. The screen display
for the new primer provides information about the primer and its evaluation, and about the molecule in
the region around the primer.

The molecule sequence is shown across the center of the screen, with the 5’ and 3’ ends marked. For
DNA molecules, a simple map showing genes or regions appears above the sequence. A horizontal line
above the map may show tick marks at some locations. These are neighboring primer sites that will
meet the criteria set.
The primer sequence is shown in a boxed area below the molecule sequence. If a 5’ extension is present,
these bases are shown as non-homologous to the molecule sequence (no vertical match lines).

Primer Evaluation Bar
The primer evaluation bar appears in a boxed display area at the bottom of the primer viewer window
on the Edit tab view. The primer is evaluated for GC content, melting temperature (Tm), presence of
dimers, stability, GC clamp, presence of runs or hairpins and possible false priming. The icon at the left
edge of the evaluation bar indicates whether or not the current primer satisfies all of the criteria set.
The primer meets all of the criteria set. Click the Analyze tab to find out more about this primer
or print a primer design report. Click the Info tab for molecule-associated information and to
save the primer to disk for later use, if desired.

The primer does not meet one or more of the criteria set. Values that do not meet criteria will
appear in color. You can click on the value in the Evaluation Bar to jump to the appropriate view
on the Analyze tab for more details. (Click the Edit tab to return.)
If the primer does not meet criteria, you can adjust the primer position or primer length until you find a
primer that does meet criteria. If necessary, you can also change the primer 5’ extension.

Adjust Primer Position
Four toolbar buttons can be used to move the primer to the left or right within the sequence, thereby
changing the bases in the primer sequence. You can move the primer one basepair position at a time or
you can jump to the next position that meets the criteria specified. The nearby positions that will meet
the criteria set appear as tick lines on the horizontal line above the map.
Use the Move Left or Move Right (single arrowhead) buttons or the keyboard left or right arrow
keys to move the primer one bp position in the direction of the arrow. Use the Scan Left or Scan
Right (double arrowhead) buttons or the Ctrl + arrow keys on the keyboard to move the primer in that
direction to the next position that meets the criteria set. Once moved, the primer will be re-evaluated in
its new position.

Adjust Primer Length or Change Primer 5’ Extension
You can increase or decrease the length of the primer, as needed. Click the Increase Primer
Length button to add one base to the 3’ end of the primer. Click the Decrease Primer Length
button to remove one base from the 3’ end of the primer. You can modify the primer 5’ extension, if
necessary. Click the Edit 5’ Extension button and then enter or edit the 5’ extension for this primer.
Our sample primer was moved to the left using the Scan Left button to the nearest position that would
meet the criteria set. Click the Analyze tab to see detailed analysis information about this primer.

Analyze Primer
The Primer Report (shown above) gives the criteria settings used to evaluate this primer, the actual
values for each item, and an indication of whether the criteria were met.
Click toolbar buttons in this window to get more detailed information about primer Dimers, Cautions
(stability, runs, repeats, hairpins), False Priming, or Any Homologies found.

View Primer Information
Click the Info tab to review or edit information about this primer, add the primer to one of your primer
collections or export the primer sequence.
The Info display shows the primer sequence, including the 5’ extension, primer length, evaluation
results, composition, molar absorbance. A molecule map shows the approximate primer location and
the basepair position in the linked molecule. Click the Print button on the main toolbar to print a
comprehensive report for your records.

Click the Add to Collection button to add this primer to one of your primer collection files. Select
the collection file from the list shown.
Click the Export Primer Sequence button to export the primer sequence to a plain ASCII (DOS)
text file or to copy to the Windows Clipboard for use in another application.

Align Multiple Sequences
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Clone Manager can align multiple sequences against a reference sequence using a global or assembled
procedure or do an exhaustive pairwise global alignment of all sequences with a progressive assembly of
the alignments (multi-way alignment). Alignment results are displayed in a tabbed window – view a
table of information summarizing the alignment results, the actual aligned sequences in a variety of
formats, a set of simple maps showing areas of significant similarity for each sequence, or a dendrogram
for multi-way phylogeny. You can save the alignment setup or results to a disk file.
To get started:
•
•
•
•
•

Click Align, Align Multiple Sequences.
Set the Alignment Type to Global-Ref, Multi-Way or Assembled (see below).
In the lower area, set the option to align sequences as DNA bases, Amino acids
(translate in frame), or Translation (display as DNA).
Select the Scoring Matrix or use the default setting.
Click Next to identify the sequences to align.

Global-Ref Alignment – will align each of the sequences against a reference sequence (always in
position 1). The objective is to maximize the number of matching bases over the full length of each
molecule. This type of global alignment works best when sequences are of similar size and reasonably
related to the reference molecule.
Multi-Way Alignment – will do exhaustive pairwise global alignments of all sequences and progressive
assembly using Neighbor-Joining phylogeny. When the alignment is complete, you will have the option
to re-order the sequences based on the phylogenetic data produced.

Assembled Alignment – will compare each sequence against the reference sequence (always in position
1), looking for significant regions of local homology to lock in (using the FastScan – MaxQuality method).
The alignment is then completed using a global alignment procedure to align the rest of each sequence
against the reference sequence. This type of alignment can be useful when one or more areas of strong
similarity are found in otherwise poorly-related sequences.
To select sequences to align:

•
•
•
•
•

Click the Add Molecule button (at the right)
Select a sequence or group from the molecule list or click Browse to open another file.
To remove a sequence, select (highlight) it and then use the Remove Molecule button.
Use the Move Up or Move Down buttons to move the highlighted sequence
within the list, if needed. The reference molecule should always be in position 1.
Click Finish to complete the setup and start the alignment.

To align only a part of a molecule sequence or to change the molecule name to display:
•
•
•
•
•
•

Select (highlight) the name of the molecule.
Click the Identify Region button (at the right)
Click Partial Sequence to align less than the full molecule and enter the start and end basepair
positions. The start base should always be the first nucleotide to be aligned.
Use the Complement checkbox if the region to be aligned is on the complement strand.
Type in a name to display if you need to shorten or change a molecule name.
Click OK to complete this item.

Alignment Results
When an alignment operation has been performed, the alignment results will be displayed in a
comprehensive, tabbed viewing window. Click the tabs to access alternate views of your results.
Toolbar buttons let you sort data, navigate through results lists, format the display style for aligned
sequences, or view additional data, where applicable. You can print the data in a view window, copy this
view to the clipboard, or export the view data to a disk file.

Info Tab
The Info tab provides a table of information that gives a concise overview of the multiple sequence
alignment results, including the sequences and regions aligned, the number of matches found, the
number of non-matches found, and the calculated percent matching bases.

When you move the mouse over a molecule name in the table, the cursor changes to a rectangle.
Use this special cursor to click on a molecule name to see a pop-up box that will give you more
information about this molecule (name, size, file name, description).
You can use Tools, Redefine to return to the alignment setup dialog box to change the alignment setup,
if needed, and then repeat the alignment.

Sequence Tab
You can view the actual aligned sequences in a variety of formats, emphasizing the differences or
similarities between the sequences. Click the Sequence tab to access this view.

Click the Show Similarity/Difference button to toggle between the default similarity and default
difference formats to get a rapid impression of which view will give you the best display.
The default similarity format shows all bases and uses color to distinguish areas with high matches. The
default difference format shows only bases that do not match the reference sequence and uses
background color to bring these to your attention. In the difference formats, dots indicate matches.
Some formats apply color if the similarity exceeds a specified value (Color areas of high matches or
Similarity summary bars format). Use the Similarity Significance Value combo box in the toolbar to set
the level of significance (range 50-100%) you want to apply for these formats.
Click the Settings button to access the full set of sequence format options or to set page style
options. When the format is just the way you want it, you can print, copy or export the data.

Location Map Tab
You can click the LMap tab to view a summary of the extent and location of similarity of the sequences
and additional information about regions of DNA or protein molecules. Each of the sequences is shown
on a separate line. The entire search region is shown for each molecule, scaled to fit in the data box.
For global alignments, each sequence is compared to the reference sequence. For multi-way or two-way
alignments, each sequence is compared with a virtual composite sequence. You can set the significance
value for this display using the Similarity Significance Value combo box in the toolbar.

Regions where similarity is greater than or equal to the significance value are marked with colored bars.
For assembled alignments, a blue bar indicates that the molecule is being aligned 5’ to 3’, while a light
red bar indicates the molecule is being aligned in the reverse direction (3’ to 5’). You can point with the
mouse at a map area and depress the left mouse button to see the basepair position at the cursor
location. You can also view composition data as an overlay on top of the similarity data. Click Tools to
compress the view to show more lines of data or to overlay composition data.

Picture Tab
If a multi-way alignment has been performed, you can click the Picture tab to view a dendrogram which
suggests the pattern of relatedness of all of the sequences aligned. The dendrogram is constructed with
a distance-based tree-building method using the neighbor-joining algorithm. The amount of dissimilarity
(the distance) between two aligned sequences is used to derive the tree. The method is very fast and
results in a single tree, similar to the phylogenetic guide trees produced using the CLUSTAL W approach.

Compare Two Sequences
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Clone Manager can compare two sequences by searching for regions of local homology or by aligning
the two sequences using a global or an assembled alignment procedure. Local homology searches can
be done using the FastScan method or the Needleman-Wunsch method. Alignment results are displayed
in a tabbed window.
For local homology searches, you can view a list of the local homologies found or a set of simple maps
locating these local homologies. For each homology block listed, you can view the actual aligned
sequences or a more detailed map showing the local homology in each molecule.
To get started:
•
•
•
•
•

Click Align, Compare Two Sequences.
Set the Comparison Type to Local, Assembled, or Global (see below).
In the lower area, set the option to compare sequences as DNA bases, Amino acids
(translate in frame), or Translation (display as DNA).
Set the checkbox if both DNA strands should be compared.
Click Next to identify the sequences to compare.

Compare with Local Homology Searches – compare two sequences by searching for regions of local
homology. Select to use the FastScan or Needleman-Wunsch method. Once the local homology search is
complete, you can view a list of best regions found, the aligned sequences or view a location map.
Compare with Assembled Alignment – compare two sequences by finding significant regions of local
homology (using the FastScan – MaxQuality method) and then completing the alignment using a global
alignment procedure. This type of comparison can be useful when one or more areas of strong similarity
are found in otherwise poorly-related sequences.

Compare with Global Alignment – compare two sequences using a global alignment procedure. The
objective is to maximize the number of matching bases over the full length of each molecule. This type
of global alignment works best when sequences are of similar size and reasonable related to each other.
To select sequences to compare:

•
•
•
•

Click the Change button to the right of the molecule name box for Sequence 1
Select a sequence from the molecule list or click Browse to open another file.
Repeat this procedure for Sequence 2
Click the Flip button to exchange the sequences between the boxes, if needed.

To compare only a part of a molecule sequence:
•
•
•
•

Below the molecule name, click Partial Sequence
Enter the start and end basepair positions of the region. The start base should always be the
first nucleotide to be compared.
Use the Complement checkbox to indicate that the region is on the complement strand.
Click Finish to complete the setup instructions and begin the sequence comparison.

View Results
Results of local alignments include a sortable list of homologies found, shown in table or graphic format.
For each homology block listed, you can also view the aligned sequences or a detailed map of the local
homology region.

Info Tab
The Info tab shows a table that lists the regions of local homology found in two-sequence comparisons
using the Local Homology option. You can use the combo box in the toolbar to sort the results by score,
percent matches, length, or the start position of the region of homology in either molecule. Score is a
composite value that reflects the number of aligned matching bases with penalties for mismatched
bases or gaps in the alignment.

Our sample results are sorted by score. You can move the highlight bar to any region of homology
found. When you click the Sequence or LMap tabs, you will see the aligned sequence data or a detailed
map for this selected homology block.

Picture Tab
Click the Picture tab to get a graphic view of the list of regions of homology found. This view consists of
a set of simple maps locating these local homologies. Each entry shows the region of local homology as a
colored bar, between lines representing the two molecules. Like the Info tab view, you can sort these
results and move the highlight bar to select a region in order to view sequence or detailed map data.

Sequence Tab
You can view the actual aligned sequences in a variety of formats, emphasizing the differences or
similarities between the sequences. Click the Sequence tab to access this view. The default view shows
only non-matching bases (difference format), with a dot used to indicate a match. The background area
behind non-matching bases is colored to assist with finding these non-matches.
Some formats apply color if the similarity exceeds a specified value (Color areas of high matches or
Similarity summary bars format). Use the Similarity Significance Value combo box in the toolbar to set
the level of significance (range 50-100%) you want to apply for these formats.
Click the Show Similarity/Difference button to toggle between the default similarity and default
difference formats to get a rapid impression of which view will give you the best display.

Click the Settings button to access the full set of sequence format options or to set page style
options. When the format is just the way you want it, you can print, copy or export the data.

Click the Next Result or Previous Results toolbar buttons to navigate through the list of local
homologies found without leaving the sequence view.

Location Map Tab
For each region of local homology, you can view a map showing the approximate position of the region
of homology within each of the molecules. Click the LMap tab to access this view. Molecule names are
shown, along with homology block basepair coordinates. The regions of local homology appear as
colored bars. Homologous regions on the normal strand appear in blue, while regions on the
complement strand appear in light red. Click the Next Result or Previous Result toolbar buttons to
navigate through the list of local homologies found without leaving this view window.

